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MISSION AND VISION OF THE INSTITUTE:
Our Vision:

To establish as an ideal academic institution in the service of the nation the world and the humanity
by graduating talented engineers to be ethically strong globally competent by conducting high
quality research, developing breakthrough technologies and disseminating and preserving
technical knowledge.

Our Mission:
To fulfill the promised vision through the following strategic characteristics and aspirations:

o Contemporary and rigorous educational experiences that develop the engineers and
managers;

e Anatmosphere that facilitates personal commitment to the educational success of students
in an environment that values diversity and community;

e Prudent and accountable resource management;

o Undergraduate programs that integrate global awareness, communication skills and team
building across the curriculum;

o Leadership and service to meet society’s needs;

o Education and research partnerships with colleges, universities, and industries to graduate
education and training that prepares students for interdisciplinary engineering research and
advanced problem solving;

o Highly successful alumni who contribute to the profession in the global society.
Vision and Mission statements of the Department of Mechanical Engineering:
Vision Statement:

“The Mechanical Engineering Department strives immense success in the field of education,
research and development by nurturing the budding minds of young engineers inventing sets of
new designs and new products which may be envisaged as the modalities to bring about a green
future for humanity”

Mission Statement:

1. Equipping the students with manifold technical knowledge to make them efficient and
independent thinkers and designers in national and international arena.

2. Encouraging students and faculties to be creative and to develop analytical abilities and
efficiency in applying theories into practice, to develop and disseminate new knowledge.




3. Pursuing collaborative work in research and development organizations, industrial
enterprises, Research and academic institutions of national and international, to introduce
new knowledge and methods in engineering teaching and research in order to orient young
minds towards industrial development.

PROGRAM EDUCATIONAL OBJECTIVE

PEO 1: Graduates shall have knowledge and skills to succeed as Mechanical engineers for their
career development.

PEO 2: Graduates will explore in research.

PEO 3: Mechanical Graduates shall have the ability to design products with various
interdisciplinary skills

PEO 4: Graduates will serve the society with their professional skills




PROGRAM OUTCOMES

A

Engineering Knowledge: Apply the knowledge of mathematics, science, engineering
fundamentals and an engineering specialization for the solution of complex engineering
problems.

Problem Analysis: Identify, formulate, research, review the available literature and analyze
complex engineering problems reaching substantiated conclusions using first principles of
mathematics, natural science and engineering sciences.

Design and development of solutions: Design solutions for complex engineering problems
and design system components or processes that meet the specific needs with appropriate
considerations for public health safety and cultural, societal and environmental
considerations.

Conduct investigations of complex problems: Use research based knowledge and research
methods including design of experiments, analysis and interpretation of data and synthesis
of the information to provide valid conclusions.

. Modern tool usage: Create, select and apply appropriate techniques, resources and modern

engineering and IT tools including predictions and modeling to complex engineering
activities with an understanding of the limitations.

The Engineer and society: Apply reasoning, informed by the contextual knowledge to
assess societal, health, safety, legal and cultural issues and the consequent responsibilities
relevant to the professional engineering practices.

Environment and sustainability: Understand the impact of the professional engineering
solutions in society and environmental context and demonstrate the knowledge of and need
for sustainable development.

Ethics: Apply ethical principles and commitment to professional ethics, responsibilities
and norms of the engineering practice.

Individual and team work: Function effectively as an individual and as a member or leader
in diverse teams and in multi-disciplinary settings.

Communication: Communicate effectively on complex engineering activities with the
engineering community and with the society at large, such as being able to comprehend,
write effective reports, design documentation, make effective presentations, give and
receive clear instructions.

Project management and finance: Demonstrate knowledge and understanding of the
engineering and management principles and apply these to one’s own work, as a member
and leader in a team, to manage projects and in multidisciplinary environments.

Life — long learning: Recognize the need and have the preparation, ability to engage in
independent and life — long learning in the broadest context of technological change.

PROGRAMME SPECIFIC OUTCOMES:

PSO1:

Students acquire necessary technical skills in mechanical engineering that make them

employable graduate.
PSO2: An ability to impart technological inputs towards development of society by becoming an
entrepreneur.




COURSE OBJECTIVES:

1. To be able to understand and handle design problems in a systematic manner.
2. To be able to apply CAD in real life applications.

3. To be understand the basic principles of different types of analysis.

COURSE OUTCOMES:

ME 383.1 Able to solve simple problems using FEA software.

ME 383.2 Generate freeform shapes in part mode to visualize components.

ME 383.3 Create complex engineering assemblies using appropriate assembly constraints.
ME 383.4 Develop G and M codes for turning components.

ME 383.5 Develop G and M codes for milling components.

ME 383.6 Generate automated tool paths for given engineering component.

INSTRUCTIONS TO THE STUDENTS




N

10.

11.

Every student should obtain a copy of the laboratory manual
It is important that all students arrive at each session on time.
Dress code: Students must come to the laboratory wearing:

e Trousers.

e half-sleeve tops.

e Leather shoes.

e Half pants, loosely hanging garments and slippers are not allowed.
Students should come with thorough preparation for the experiment to be conducted.
Students will not be permitted to attend the laboratory unless they bring the practical
record fully completed in all respects pertaining to the experiment conducted in the
previous class.
Experiment should be started only after the staff-in-charge has checked the experimental
setup.
All the calculations should be made in the observation book. Specimen calculations for one
set of readings have to be shown in the practical record.
Wherever graphs are to be drawn, A-4 size graphs only should be used and the same should
be firmly attached to the practical record.
Practical record and observation should be neatly maintained.
They should obtain the signature of the staff-in-charge in the observation book after
completing each experiment.
Theory regarding each experiment should be written in the practical record before
procedure in your own words.

LABORATORY SAFETY PRECAUTIONS




Laboratory uniform, shoes & safety glasses are compulsory in the lab.

Do not touch anything with which you are not completely familiar. Carelessness may not
only break the valuable equipment in the lab but may also cause serious injury to you and
others in the lab.

Please follow instructions precisely as instructed by your supervisor. Do not start the
experiment unless your setup is verified & approved by your supervisor.

Do not leave the experiments unattended while in progress.

. Do not crowd around the equipment’s & run inside the laboratory.

During experiments material may fail and disperse, please wear safety glasses and maintain
a safe distance from the experiment.

If any part of the equipment fails while being used, report it immediately to your supervisor.
Never try to fix the problem yourself because you could further damage the equipment and
harm yourself and others in the lab.

Keep the work area clear of all materials except those needed for your work and cleanup

after your work.




© 0o N o g B~ w

LIST OF EXPERIMENTS

LIST OF EXPERIMENTS

Sketching: Development of part drawings for various components in the form of
orthographic Representation of dimensioning and tolerances.

Part Modelling: Generation of various 3D Models through Protrusion, revolve, sweep.
Design of simple components.

Determination of deflection and stresses in 2D and 3D trusses and beams.

Determination of deflections, principal and VVon-mises stresses in plane stress.
Determination of stresses in 3D and shell structures (at least one example in each case)
Estimation of natural frequencies and mode shapes, Harmonic response of 2D beam.
Study state heat transfer analysis of plane and axi-symmetric components.

Development of process sheets for various components based on Tooling and Machines.

Development of manufacturing defects and tool management systems.

. Study of various post processors used in NC Machines.
11.
12.

Development of NC code for free form and sculptured surfaces using CAM software.
Machining of simple components on NC lathe and Mill by transferring NC Code / from
CAM software.




What is CAD/CAM?
CAD/CAM (computer-aided design and computer-aided manufacturing) refers to computer
software that is used to both design and manufacture products.

CAD is the use of computer technology for design and design documentation. CAD/CAM
applications are used to both design a product and program manufacturing processes,
specifically, CNC machining. CAM software uses the models and assemblies created in CAD
software to generate tool paths that drive the machines that turn the designs into physical parts.
CAD/CAM software is most often used for machining of prototypes and finished parts.

Why CAD/CAM?

Computer Aided Design and Computer Aided Manufacture is the way things are made these
days. Without this technology we wouldn’t have the range and quality of products available or, at
least, they wouldn’t be available at a price most of us can afford. Hand-building and manual
techniques still very much have their place and Design Education needs to treasure and foster
these skills so that future generations will have the , hands-on* skills to understand the man-
made world and a solid modeling system is usually an interactive computer graphics system that
is intended to create true three-dimensional components and assemblies. Recent advances in
CAD software, computers, and graphical displays have made it possible to use solid
representations of components being considered in the design process. These solid models can
be employed in numerous ways.

Advantages of Solid Modeling

A realistic visual display: By producing a shaded visible surface image of the solid, solid modeling
allows a designer to see exactly what has been created. Easy to deal with different views: Once a
part has been created, we have the ability to rotate, shade, section, or produce almost any view
required by a designer.

Single associated model database: The solid modeler provides the only database suitable for all
CAD operations. Almost all information needed for part generation is contained in the solid
model. The algorithm should be able to ensure that it represents physically possible shape that is
complete and unambiguous Applications. e.g., automatic generation of a mesh for a finite
element analysis. Provide the next generation of engineers, designers and technicians. All of
these professionals will be using CAD/CAM techniques or CAD/CAM products in their work,
alongside practical hands-on skill. Design and Technology education has to reflect modern
practice so it is crucial that students have the opportunity to use real CAD/CAM tools in their
designing and making.

DESIGN PROCESS AND ROLE OF CAD

1. Recognition of need

2. Definition of problem

3. Synthesis

4. Analysis and optimization
5. Evaluation

6. Presentation




SOLID MODELING

REQUIREMENTS FOR MODELING ASSEMBLING
1. Part modeling and analysis

The part analysis includes the material type, mass and inertial properties, functional properties of
the faces, etc.

2. Hierarchical relationships
An assemble tree and assemble sequence must be given.

3. Mating conditions.

There are two methods for specifying mating conditions: Specify the location and orientation of
each part in the assembly, together with the representation of the part itself, by providinga 4 x 4
homogeneous transformation matrix. (i.e., transformation from MCS to WCS).

Specify the spatial relationships between its individual parts as mating conditions.

CAD/CAE/CAM Data Exchange

Computer databases are now replacing paper blueprints in defining product geometry and non-
geometry for all phases of product design, analysis, and manufacturing. It becomes increasingly
important to find effective procedures for transferring data among CAD/CAE/CAM systems.

The need to exchange modeling data is directly motivated by the need to integrate and automate
the design and manufacturing process to obtain the maximum benefits from CAD/CAE/CAM
systems. Four Types of Modeling Data to be transferred:

(1)Shape

(2)Non shape
(3)Design

(4) Manufacturing

(1) Shape data consists of both geometrical and topological information as well as part features.
Entity attributes such as font, color, and layer as well as annotation is considered part of the
entity geometrical information. Topological information applies only to products described via
solid modeling. Features allow high-level concept communication about parts.

Examples are hole, flange, web, pocket, chamfer, etc.

(2) Non shape data includes graphics data such as shaded images, and model global data as
measuring units of the database and the resolution of storing the database numerical values.

(3) Design data has to do with the information that designers generate from geometric models for
analysis purposes. e.g., mass property and finite element mesh data.




(4) Manufacturing data consists of i nformati on such as tooling, NC tool paths, tolerancing,
process planning, tool design, and bill of materials.

Commonly Used CAD Data Exchange Format:
IGES (Initial Graphics Exchange Specification)
PDES (Product Data Exchange Using STEP)

IGES is focused on CAD-to-CAD exchange where primarily shape and non shape data were to be
transferred from one system to another.

PDES is previous called Product Data Exchange Standard. It is for the exchange of complete product
descriptions which covers the four types of modeling data (i.e., shape, non shape, design and
manufacturing).

Other data exchange interfaces include: STL, Neutral, SET, ECAD, VDA, STEP, PDGS, CATIA, Render,
CGM, VRML, PATRAN, TIFF, etc.




EXERCISES



Auto CAD

Exercise — 1

Aim : To create a 2D view of the given diagram using Auto CAD.

Procedure:

. Type limits in command menu & set value to 297,290.

. Change the units to millimeters from inches and also precision to

0 by clicking format -> units ->ok.

. To set the paper size type zoom -> enter and type a -> enter in

Command bar.

. Draw the 3 concentric circles with diameters 94, 74 & 54
.Draw the two axis lines from centre of circles
.Draw the vertical line from the centre of circle

.From the modify tool bar, use the array command to draw the 6holes with

12dia from centre of circles

. Now draw the 30° line by use the vertical line
. Then mirror the 30° line, with vertical line
. Again draw the concentric of radius 100 from centre of circle

. From the modify toolbar, use the offset command to draw the 12 & 23

distance circle.

. Draw 2 circles. With radius 23 & 12 on the 100R circle where the 30°

line co-inside.

.. From modify toolbar, mirror these circle to represent the another side.

. And offset vertical line from centre of circle with a distance both side of

vertical line.




15. . From modify toolbar, use the fillet command to represent fillet of

radius 10 &9 to the offset line.

16. . Trim the unwanted lines to get required 2D drawing

6 holes 12Dia '\

&
W

Result: Hence the required 2D diagram is created using Auto CAD.

Viva Questions

. What is CAD?

. What is the difference between Pan and Zoom?

. What is the difference between line and spline?

. What is the difference between chamfer and fillet?
By how many ways can you draw a circle?

Quadrant



Exercise — 2

Aim: To create a 2D view of the given diagram using Auto CAD.

Procedure:

Type limits in command menu & set values to 200,200.

Change the units to millimeters from inches and also precision to 0 by
clicking format -> units -> ok.

To set the paper size type zoom -> enter and type a -> enter in command bar
Draw 2 lines as the axes and draw concentric circles of specified diameter.
Draw a ray of 30° angle to the +ve Y axis as shown in the figure and a ray of
angle 60° to the —ve Y axis as shown in the figure.

Draw concentric circles from the point where the circle meets the positive Y
axis as show.

Now trim the circles to get appropriate shape.

Continue with the design until the AutoCAD drawing his complete.

Give the dimensions from the dimension tool bar as in diagram.

\(—I’"‘\\ _—R200

P




Result: Hence the required 2D diagram is created using Auto CAD.

Viva Questions

. What is the difference between line and Spline?

. What is the difference between chamfer and fillet?
. What are different ways to draw a circle?
. What are the possible ways to draw an arc?
How to extend a line?
. What is the procedure to enter into AutoCAD?




Exercise — 3

Aim: To create a 2D view of the given diagram using Auto CAD.
Procedure:

. Type limits in command menu & set values to 45,45
. Change the units to millimeters from inches and also precision to 0 by
clicking format -> units -> ok.
. To set the paper size type zoom -> enter and type a -> enter in command bar
Draw the 3 concentric circles of diameters 85 ,62,32
Draw the 2 axes lines from the centre of the circles
Draw the circle with 14dia on 62dia of circle and offset of the vertical line
with distance 4 to both sides of the vertical line
. Then trim the unwanted lines
Use the array command from modify tool bar to represent the 6 holes with
14 dia of centre of the circles
. Offset the vertical and horizontal axes with 47 and 52 distance
. And draw the 2 circles with 14 radius and 12 dia at coincide of the offset
axes
. From the modify tool bar select the fillet command to represent the 12R
fillet
. Then mirror this to require the 2D drawing
. Finally trim the unwanted lines and circles

)
NP

4 holes 12 Dia
Cover




Result: Hence the required 2D diagram is created using Auto CAD.

Viva Questions

. What are the possible ways to draw arc?
How to extend line?
. What is the purpose of command trim?
How to convert 2D drawings to 3D drawings?

How to give dimension?




Exercise — 4

Aim: To create a 2D view of the given diagram using Auto CAD.

Procedure:

. Type limits in command menu & set value to 297,290.

. Change the units to millimeters from inches and also precision to 0

by clicking format -> units -> ok.

. To set the paper size type zoom -> enter and type a -> enter in

4.

Command bar.
Draw the 2 axes lines
Draw 2 concentric circles of diameter 58 and 40 above the axes

Draw the 10dia circle on the 40dia of the circle

. And use the array command from modify tool bar to represent the 8 holes

14.

15

with 10dia from centre of the circles.
Draw the 2 concentric circles of diameter 58 & 36 below the axes

Draw the circles of the diameter 8 on the circle of 36dia

. Use the array command from the modify tool bar to represent the 6 holes

with 8dia

. Draw the 2 concentric circles of diameter 22 and 20 radius at the right side

of the vertical line from the vertical axes.

. Fillet the circles of radius 20 with 15 radiuses.

. And again draw the circles of diameter 16& 20R at left side of the vertical

line from the vertical axes.

And chamfer the circles of radius 20 with 58dia circle

. Then trim the unwanted lines to get the required 2D drawing.




8 holes 10 Dia

{

6 holes 8lia

e ———

Housmg

Result: Hence the required 2D diagram is created using Auto CAD.

Viva questions

. What is the purpose of command trim?

. How to convert 2D drawings to 3D drawings?

. What is the difference between Pan and Zoom?
. What is difference between circle and ellipse?

. What is the difference between rectangle and polygon?




Exercise — 5

Aim: To create a 2D isometric view of the given diagram using Auto CAD.

Procedure:

. Type limits in command menu & set value to 297,290.

. Change the units to millimeters from inches and also precision to 0 by
clicking format -> units -> ok.

. To set the paper size type zoom -> enter and type a -> enter in command bar.

. Go to drafting settings and turn on isometric snap..

. Use the F5 key to change between the views of isometric planes.

. Start from the front view and draw the the line of length of line 104 using the
F8 key (O snap key) and continue with the 48 length line.

. Change to top plane and draw the 72mm line.

. Continue in the same fashion to complete the whole figure.

. Give the dimensions from the dimension tool bar as in diagram.

e
Ty

O

D \

L |

Result: Hence the required 2D isometric diagram is created using Auto CAD.

Viva questions

. What is the difference between metric unit and English unit?
. What is the shortcut key for Ortho ON/OFF ?
. What is the shortcut key for help?
. What are the various ways to draw a measured line?
.What are object snap command.
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EXERCISE — 1
Drafting using CATIA V5

Obijective:
e To develop the part drawings of given component using CATIA V5.
Out comes:

e Understand how to use sketcher commands to complete the given sketch.
e Understand the importance of using limits and view settings.

Scope of the experiment:

To provide an introduction to the use of sketcher commands in drawing 2D sketch and
experience them how to apply and where to apply the various commands. Know the difference
between draw and modify commands.

Description of software:

The software used for doing this sketch is catia v5 and it is developed by Dassault Systémes.
CATIA software(/ka 'ti:a/, an acronym of computer-aided three-dimensional interactive
application) is a multi-platform software suite for computer-aided design (CAD), computer-aided
manufacturing (CAM), computer-aided engineering (CAE), PLM and 3D, developed by the
French company Dassault Systémes. It is a three dimensional modeling tool. This tool is used in
the design of various objects such as vehicles, buildings, components, etc.

Tacke  Aveyae Wedoe 1D
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Figure 1-3 [Initial screen that appears after starting CATIA V5R13



Note
aj Even if you draw any sketch in the space containing the hidden elements, it will not be visible
and will be displayed only after you return back to the visible geometry area.

You can change the standard element to a construction element in this space or vice-a-versa.

Procedure

In this exercise, you will draw the sketch of the model shown in Figure 1-31.
The sketch is shown in Figure 1-32. You will not dimension the sketch. The solid model and
the dimensionsare given only for your reference.

R30
230

Figure 1-31 Solid Model for Tutorial 1 Figure 1-32 Sketch of the model
The following steps are required to complete this tutorial:

a. Start CATIA V5 and then start a new CATpart file.

b. Draw the sketch of the model using the Line, Arc, and Circle tools, refer to Figures 1-35
and 1-36.

c. Save and close the file.

Starting CATIA V5 and Opening a New Part File

1. Start CATIA V5 by choosing Start > Programs (All Programs if you are working with
Windows XP > CATIA > CATIA V5R13 or by double-clicking on the shortcut icon of
CATIA V5R13 available on the desktop of your computer.

A new Productl file is started.

2. On choosing Close from File menu, the start screen of CATIA V5 is displayed. Choose
Start > Mechanical Design > Part Design to make sure that you are in Part Design
workbench. To open a new file in Part Design workbench, choose File > New from
menu bar. The New dialog box is displayed, as shown in Figure 1-33.
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Figure 1-33 Selecting Part from the New dialog box

3. Select Part from the List of Types list box from this dialog box and choose the OK
button.

A new file in the Part Design workbench is opened.
4. Choose the Sketcher button from the Sketcher toolbar and then select the YZ

plane as the sketching plane, to invoke the Sketcher workbench. The screen that
is displayed by invoking the Sketcher workbench, is shown in Figure 1-34.
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Figure 1-34 Sketcher workbench screen



You will draw the sketch in two sections, first as the outer loop and second as the inside circle.

Drawing the Outer Loop of the Sketch

It is recommended to create the sketch symmetrically around the origin. This will reduce
the time required for constraining and dimensioning the sketches. The outer loop of
sketch can be drawn using the Line and the Arc tools. You will start drawing the outer
loop from the lower left corner of the sketch.

Invoke the Line tool by choosing the Line button from the Profile toolbar. /
Choose the Snap to Point button from the Sketch tools toolbar, if not already chosen.

Move the cursor in the third quadrant. The coordinates of the point will be displayed
along with the cursor.

Click at the point whose coordinates are -50mm, -30mm, and then move the cursor
horizontally toward the right.

You will notice that the color of line turns blue, when you move the cursor horizontally.

M. Note

%. Whenever a line turns blue while drawing, it means that the line is constrained. The constraint
B - . . . . . . . . .

g may be horizontal or vertical, depending on the direction in which the line is drawn.

All the constraints that are applied to the drawn sketch will not be explained in this tutorial. You
will learn about such constraints individually in later chapters.

Refer to Figure 1-32. The length of the first horizontal line at the lower left corner of the
sketch is 30mm. Therefore, move the cursor until the length of the line is shown as
30mm in the L edit box of the Sketch tools toolbar.

Press the left mouse button, when the length of the line in the L edit box of the Sketch
tools toolbar displays a value of 30mm.

The first horizontal line is drawn. You will notice a Horizontal constraint is applied on it.
After the line is drawn, it is still active and is displayed in orange color. Left click in the
geometry area to make sure it is no more selected.

As soon as you specify the endpoint of line, the Line tool is terminated. Therefore, you
need to choose this button again and again to draw multiple lines. You can avoid this by
double-clicking on the Line button in the Profile toolbar. Now, the line tool will not be
terminated until you terminate it by pressing ESC key twice on the keyboard.

Double-click on the Line button to invoke the Line tool and select the endpoint of the
first horizontal line.

7. Press the TAB key thrice on the keyboard to highlight the value displayed in the L edit



10.

box of the Sketch tools toolbar. Type 8 in this edit box and press the ENTER key.
Now move the cursor vertically upward and click when a vertical line is displayed.

A vertical line of length 8mm will be drawn. You will notice that this line is no longer in
the select mode and you are prompted to select the start point of the next line. This is
because of double-clicking on the Line button. It makes the Line tool active till you
invoke any other tool.

Select the endpoint of the vertical line as the start point of the second horizontal line.
Enter 75 in the L edit box of the Sketch tools toolbar. Move the cursor horizontally
toward the right and click when a horizontal line is displayed.

This draws the second horizontal line of length 75mm.

Select the endpoint of the second horizontal line, as the start point of the second vertical
line and move the cursor vertically downward. Click when the length of the line in the L
edit box shows a value of 8mm.

This draws the second vertical line of length 8mm.

@y, Note
%. You will notice that while drawing the second vertical line, the inferencing line is displayed in
D >

11.

12.

13.

14.

15.

16.

the geometry area. The inferencing lines are often displayed whenever the endpoint of a line is
constrained, with an element already available in the sketch.

Select the endpoint of the second vertical line as the start point of the third horizontal
line and move the cursor horizontally toward the right. Click to draw the third horizontal
line, when the length of the line in the L edit box shows a value of 45mm.

Select the endpoint of the previous line as the start point of the third vertical line and
move the cursor vertically upwards. Click when the length of the line is 50mm.

This draws the third vertical line of length 50mm. Next, you can draw the arc.

To draw the arg, first invoke the Circle toolbar, by choosing the down arrow available on
the right of the Circle button, from the Profile toolbar. Choose the Three Point Arc
button from to invoke the Three Point Arc tool.

Select the start point of the arc as the endpoint of the previous vertical line and click on it.

Move the cursor to a point whose coordinates are 70mm, 50mm. These are displayed in
the Sketch tools toolbar and also on top of the cursor. Click on this point to define the
second point.

Move the cursor to specify the third point of the arc. Click on the point when the cursor
snaps a location 40mm, 20mm in the geometry area. The coordinate values are
displayed on top of the cursor.



17.

18.

19.

20.

21.

22.

This draws the arc for the outer loop. As the arc is in selection mode, click anywhere in
the geometry area to end the selection mode. Now, to continue drawing the outer loop,
you need to invoke the Line tool again.

Double-click on the Line button from the Profile toolbar to invoke the Line tool.

Select the endpoint of the arc as the start point of the fourth vertical line. Move the
cursor vertically downward to draw it. Click when the length value of the line is 20mm in
the L edit box of the Sketch tools toolbar.

This draws the fourth vertical line of length 20mm. The line is no longer in selection
mode and you are prompted to enter the start point of the next line.

Select the endpoint of the previous line as the start point of the fourth horizontal line.
Move the cursor horizontally toward left. Click when the length of the line in the L edit
box of the Sketch tools toolbar shows a value of 80mm.

This draws the fourth horizontal line of length 80mm. Note that the line is green in
color, as it passes through the origin.

Select the endpoint of the previous line as the start point of the inclined line. Move the
cursor such that the line is drawn at an angle of 225-degree. The current angle will be
displayed in the A edit box of the Sketch tools toolbar. Click when a vertical inferencing
line is displayed between the endpoint of the inclined line and the start point of the first
horizontal line. This draws the inclined line of horizontal length values 10mm.

Select the endpoint of the inclined line as the start point of the next line. Move the
cursor vertically downwards. Click when the length of the line in the L edit box shows a

value of 20mm.

This completes the sketch of the outer loop. It is recommended to modify the geometry
area, such that the sketch fits in the screen. This is done using the Fit All In tool.

Choose the Fit All In button from the View toolbar to fit the current sketch on the screen. E
i

The outer loop of the sketch is completed and is shown in Figure 1-35. The display of the
constraints is turned off using the Hide/Show tool.

Drawing Inner Circle

The circle will be drawn using the Circle tool.

Choose the Circle button from the Circle toolbar to invoke the Circle tool. You @
are prompted to define the center point of the circle.

Move the cursor to a point whose coordinates are 70mm, 20mm. Click when the cursor
snaps to this point.



Figure 1-35 Outer loop of the sketch

3. Move the cursor horizontally toward the right and click when the radius of the circle in
the R edit box of the Sketch tools toolbar shows a value of 15mm. Click anywhere to
remove the circle from selection.

This completes the sketch for Tutorial 1. The final completed sketch for Tutorial 1 with
the display of constraints turned on is shown in Figure 1-36.

Figure 1-36 Final sketch for Tutorial 1

Conclusion:

After completing the sketch, you need to save it. You need to save each tutorial of this
chapter in the c01 folder, that is in the CATIA folder.

1. Choose the Save button from the Standard toolbar to invoke the Save As dialog
box. Create CATIA folder inside the \My Documents folder. Then create c01 folder @;
inside the CATIA folder.

2. Enter the name of the file as cO1tutl in the File name edit box and choose the Save
button. The file will be saved in the \My Documents\CATIA\cO01 folder.

3. Close the part file by choosing File > Close from the menu bar.



Additional Viva Questions:

. Expand CATIAVS.

. Write the function of workbench in catia v5.

. What are sketch tools in sketcher workbench.

. List the sketch tools used in catiavb.

. Can you tell which tool is used to exit from sketcher workbench.
. How to get into sketcher module from default catia window.

. Write the use of geometrical constraints.

. What are the steps required to go to part module from sketcher.
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. How do you measure arc length.
10. Mention the colors provided in catia.

Innovative Questions:

When to use geometric constraints in catia.

Can we generate 3D model with out sketcher.

On what machines catiav5 should be run.

Where can we use catia for?

How to edit existing dimension in catia?

Tell about catia applications used in design industry.
How do you make use of catiav5.

Categorize the catia versions developed by dassault system.

© oo N o g B~ wDhPE

What type of programming language uses catia.

10. Where catia v5 modules can be applicable in design.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL
1. Using the sketcher workbench design the given sketch using catia. L5
2. Choose the correct module for the given sketch to design in catia. L6
3. List the steps required and draw the given component using catia. L4
4. From the given sketch make use of correct module and complete it. L3




EXERCISE — 2
Part Modelling using CATIA V5

Objective:
e To develop the part modeling of given component using CATIA V5.

Out comes:

e Understand how to use modeling commands to complete the given sketch.
e Understand the importance of using limits and view settings.

Scope of the experiment:

To provide an introduction to the use of sketcher commands in drawing 3D sketch and
experience them how to apply and where to apply the various commands. Know the difference
between draw and modify commands.

Description of software:

The software used for doing this sketch is catia v5 and it is developed by Dassault Systémes.
CATIA software(/ka ti:a/, an acronym of computer-aided three-dimensional interactive
application) is a multi-platform software suite for computer-aided design (CAD), computer-aided
manufacturing (CAM), computer-aided engineering (CAE), PLM and 3D, developed by the
French company Dassault Systémes. It is a three dimensional modeling tool. This tool is used in
the design of various objects such as vehicles, buildings, components, etc.
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Figure 1-3 Initial screen that appears after starting CATIA V5R13



Note
Even if you draw any sketch in the space containing the hidden elements, it will not be visible
and will be displayed only after you return back to the visible geometry area.

You can change the standard element to a construction element in this space or vice-a-versa.

Procedure

In this exercise, you will draw the sketch of the model shown in Figure 1-37.
The sketch is shown in Figure 1-38. You will not dimension the sketch. The solid model and
the dimensionsare given only for your reference.

b.

C.
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Figure 1-37 Solid Model for Tutorial 2 Figure 1-38 Sketch of the model

The following steps are required to complete this tutorial:

Start a new CATpart file.

Draw the sketch of the model using the Profile and Rectangle tool, refer to Figures 1-39
through 1-41.

Save and close the file.

Starting New Part File

1.

2.

Choose File > New from the menu bar. The New dialog box is displayed.

Select Part from the List of Types list box from this dialog box. Choose the OK button.
A new file in Part Design workbench will open.

Choose the Sketcher button from the Sketcher toolbar and then select the YZ @
plane as the sketching plane, to invoke the Sketcher workbench. =

You will draw the sketch in two sections, first the outer loop and next the inner cavity.

Drawing the Outer Loop of the Sketch

You will draw the outer loop of the sketch using the Line and the Arc tool. Start drawing
the outer loop from the left corner of the sketch. It is recommended to keep the origin in
middle of the drawn sketch, as this will reduce the time required for constraining and
dimensioning the sketches. This will also helps you to capture the design intent very easily.

Invoke the Profile tool from the Profile toolbar. 6’56
by



2. Move the cursor in the third quadrant. The coordinates of the point will be displayed above
the cursor.

3. Specify the start point of the line at the point whose coordinates are -40, -30 and then
move the cursor horizontally toward the right.

You will notice that the color of line turns blue, when you move the cursor horizontally.

4. Move the cursor to a location whose coordinates are 40, -30. The coordinates of the point
can be seen on top of the cursor.

5. Specify the endpoint of the line at this location. A rubber band line is attached to the
cursor. Move the cursor vertically upward.

6. Specify the endpoint of the second line on the point whose coordinates are 40mm, -20mm.
A rubber band line is attached to the cursor.

7. Move the cursor horizontally toward the left and specify the endpoint of the third line
where the value of the coordinates is 30, -20.

After drawing these three lines, draw a tangent arc using the Tangent Arc option
available in the Profile tool.

8. Choose the Tangent Arc button available in the Sketch tools toolbar. D

9. Move the cursor to a location whose coordinates are 20, -10 and specify the endpoint of
the tangent arc. Figure 1-39 shows the sketch, after drawing three lines and the tangent arc.
The system switches back to the Line mode.

Figure 1-39 Sketch after drawing three lines and a tangent arc

10. Move the cursor vertically upward to a location whose coordinates are 20, 10.

11. Specify the endpoint of the line at this location.



12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

Next, you need to draw a tangent arc by switching to the arc mode using the Tangent Arc
option available in the Profile tool.

Choose the Tangent Arc button from the Sketch tools toolbar. D

Move the cursor to a location whose coordinates are 30, 20 and specify the endpoint of
the tangent arc.

The system switches back to the Line mode.

Move the cursor horizontally toward the right and specify the endpoint of the line, when
the value of the coordinates is 40, 20.

Move the cursor vertically upward and specify the endpoint of the line, when the value of
the coordinates is 40, 30.

Move the cursor horizontally toward the left and specify the endpoint of the line, when
the value of the coordinates is -40, 30.

Move the cursor vertically downward and specify the endpoint of the line, when the
value of the coordinates is -40, 20.

Move the cursor horizontally toward the right and specify the endpoint of the line, when
the value of the coordinates is -30, 20.

Next, you need to draw a tangent arc by switching to the tangent arc mode.

Choose the Tangent Arc button from the Sketch tools toolbar to switch the tangent D
arc mode. E
Move the cursor to a location whose coordinates are -20, 10 and specify the endpoint of
arc at this location.

The system switches back to the Line mode.

Move the cursor vertically downward and specify the endpoint of the line, where the
value of the coordinates is -20, -10.

Switch to the Tangent mode and move the cursor to a location whose coordinates are
-30mm, -20mm. Specify the endpoints of the tangent arc at this location.

Move the cursor horizontally toward the left and specify the endpoint of the line, when
the value of coordinates is -40, -20.

Move the cursor vertically downward and specify the endpoint of the line when it snaps
the start point of the outer loop. The sketch after completing the outer loop of the
sketch, after hiding the constraints, is shown in Figure 1-40.



Figure 1-40 Sketch after drawing outer loop of the sketch

Drawing the Inner Cavity of the Sketch

After drawing the outer loop of the sketch, you need to draw its inner rectangular cavity.
You will use the Rectangle tool to draw the inner cavity.

1. Choose the Rectangle tool from the Profile toolbar. ]

2. Move the cursor to a location whose coordinates are -10, 10. Specify the upper left corner
of the rectangle at this location.

3. Move the cursor to a location whose coordinates are 10, -10. Specify the lower-right
corner of the rectangle at this location.

4. Choose the Fit All in button from the View toolbar to fit the sketch in the geometry area.

The final sketch, after drawing the inner loop, is shown in Figure 1-41. Note that the
display of constraints has been turned on in this figure.

Figure 1-41 Final sketch after drawing inner loop of the sketch



Conclusion
After completing the sketch you need to save it. As mentioned earlier, you need to save
each tutorial of this chapter in the c01 folder in the CATIA folder.

1. Choose the Save button from the Standard toolbar to invoke the Save As dialog
box. Browse for the folder named c01 that you created in the last tutorial. [a;

2. Enter the name of the file as cOItut2 in the File name edit box and choose the Save
button. The file will be saved in the \My Documents\CATIA\c01 folder.

3. Close the part file by choosing File > Close from the menu bar.



Additional Viva Questions:
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. Expand CATIAVG.

. Write the function of part workbench in catia v5.

. What are modeling tools in part workbench.

. List the part tools used in catiav5.

. Can you tell which tool is used to exit from part workbench.

. How to get into part module from default catia window.

. Write the use of dimensional constraints.

. What are the steps required to go to sketch module from part.

. How do you measure arc radius.

10. Write the use of colors provided in catia.

Innovative Questions:
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When to use dimensional constraints in catia.

Can we generate 2D model with out sketcher.

On what machines catiav6 should be run.

Where can we use catia modules for?

How to edit part module in catia?

Tell about catia applications used in manufacturing industry.
How do you make use of catiav6.

Categorize the catia versions developed by dassault system.

What type of programming language uses catiav6.

10. Where catia v6 modules can be applicable in manufacturing.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL
1. Using the part workbench design the given sketch using catia. L5
2. Choose the correct module for the given sketch to design in catia. L6
3. List the steps required and draw the given component using catia. L4
4. From the given sketch make use of correct module and complete it. L3




EXERCISE — 3
Generation of 3D model using CATIA V5

Obijective:
e To develop a 3D model of given component using CATIA V5.
Out comes:

e Understand how to use modeling commands to complete the given sketch.
e Understand the importance of using limits and view settings.

Scope of the experiment:

To provide an introduction to the use of modeling and sketcher commands in drawing 3D sketch
and experience them how to apply and where to apply the various commands. Know the
difference between draw and modify commands.

Description of software:

The software used for doing this sketch is catia v5 and it is developed by Dassault Systémes.
CATIA software(/ka 'ti:a/, an acronym of computer-aided three-dimensional interactive
application) is a multi-platform software suite for computer-aided design (CAD), computer-aided
manufacturing (CAM), computer-aided engineering (CAE), PLM and 3D, developed by the
French company Dassault Systémes. It is a three dimensional modeling tool. This tool is used in
the design of various objects such as vehicles, buildings, components, etc.
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Figure 1-3 [Initial screen that appears after starting CATIA V5R13



Note
Even if you draw any sketch in the space containing the hidden elements, it will not be visible
and will be displayed only after you return back to the visible geometry area.

You can change the standard element to a construction element in this space or vice-a-versa.

Procedure

In this exercise, you will draw the sketch of the model shown in Figure 1-42. The sketch
is shown in Figure 1-43. You will not dimension the sketch. The solid model and the
dimensionsare given only for your reference.
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Figure 1-42 Solid model for Tutorial 3 Figure 1-43 Sketch for the solid model

The following steps are required to complete this tutorial:

a. Start a new CATpart file.

b. Draw the sketch of the model using the Rectangle, Profile, and the Circle tools, refer to
Figures 1-44 through 1-46.

c. Save the sketch and close the file.

Starting New Part File

1. Choose File > New from the menu bar; the New dialog box is displayed.

2. Select Part from the List of Types list box in this dialog box. Choose the OK button.
A new file in the Part Design workbench will be opened.



3. Choose the Sketcher button from the Sketcher toolbar and then select the YZ @
plane as the sketching plane.

This sketch will be drawn in two parts. Initially, you will draw the outer loop of the sketch,
that is, a rectangle. Next, you need to draw the inner loops of the sketch, which consists
of multiple inner loops that are four holes and an elongated hole. First you will draw an
elongated hole using the Profile tool and then the four holes using the Circle tool.

Drawing the Outer Loop of the Sketch

The outer loop of the sketch will be drawn using the Rectangle tool.

1. Choose the Rectangle button from the Profile toolbar. ]

s

2. Move the cursor to a location whose coordinates are -60, -50 and specify the lower left
corner of the rectangle.

3. Move the cursor to the location whose coordinates are 60, 50 and specify the upper right corner
of the rectangle. Figure 1-44 shows the outer loop of the sketch drawn using the Rectangle tool.

[1]
]

Figure 1-44 Outer loop of the sketch

Drawing the Inner Loop of the Sketch

After drawing the outer loop of the sketch, draw its inner loop.
1. Choose the Profile button from the Profile toolbar. @5

2. Move the cursor to a location whose coordinates are -30, 10 and specify the start point of
the line.

3. Move the cursor horizontally toward the right and specify the endpoint of the line, when
the value of the coordinates is 30, 10.

Next, you need to draw a tangent arc by switching over to the Tangent Arc option using
the Sketch tools toolbar.



4. Choose the Tangent Arc button from Sketch tools toolbar to switch over to the D
arc mode. k

5. Move the cursor to a location whose coordinates are 30, -10 and specify the endpoint of
the tangent arc.

The system switches over to the Line mode.

6. Move the cursor to the location whose coordinates are -30, -10 and specify the endpoint
of the line.

7. Choose the Tangent Arc button from the Sketch tools toolbar to switch over to the arc mode.

8. Move the cursor to the start point of the first horizontal line of the elongated hole.
Specify the endpoint of the arc when it snaps the start point.

The sketch, after drawing the elongated hole, is shown in Figure 1-45.

L
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Figure 1-45 Sketch after drawing the elongated hole

9. Choose the Circle button from the Circle toolbar. @

M. Note
%; Ifyou have closed the Circle toolbar, you can use the Profile toolbar to invoke the Line tool.

10. Move the cursor to a location whose coordinates are 40, 30 and specify the center point
of the circle.

11. Specify the value of 10 as the radius in the Radius edit box available in the Sketch tools
toolbar.

You will observe that a radius dimension is displayed attached to circle because you have
specified the value of the radius in the Radius edit box available in the Sketch tools toolbar.



12.

13.

14.

15.

Choose the Circle button from the Circle toolbar. @

Move the cursor to a location whose coordinates are 40, -30 and specify the
center point of the circle.

Specify the value of 10 as the radius in the Radius edit box available in the Sketch tools toolbar.
Similarly, draw the other two circles. The coordinates of the center point of other two

circles are -40, 30 and -40, -30 respectively. The final sketch, with the display of constraints
turned on, is shown in Figure 1-46.

210 El

Figure 1-46 Final sketch

Conclusion

1.

Choose the Save button from the Standard toolbar to invoke the Save As dialog _
box. Browse for the folder named c01 that you created in the first tutorial. @;

Enter the name of the file as c01tut3 in the File name edit box and choose the Save
button. The file will be saved in the \My Documents\CATIA\c01 folder.

Close the part file by choosing File > Close from the menu bar.



Additional Viva Questions:

. Expand PLM.

. Write the function of part workbench in catia v6.

. What are modify tools in part workbench.

. List the draw tools used in catiav5.

. Can you tell which tool is used to exit from drafting workbench.
. How to get into assembly module from default catia window.

. Write the use of constraints.

. What are the steps required to go to drafting module from part.
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. How do you measure a sketch in part module.
10. Mention the use of color code provided in catia.

Innovative Questions:

When to use constraints in catia.

Can we generate 3D model in drafting module directly.

On what machines catiav6 does not run.

Where can we use drafting module for?

How to edit a sketch in drafting module in catia?

Tell about surface module applications used in manufacturing industry.
How do you make use of solid modeling module.

Categorize the catia modules developed by dassault system.
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What type of modules uses catiav6 for various purposes in manufacturing industry.

10. Where catia v5 modules can be applicable in manufacturing.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL
1. Using the part workbench draft the given sketch using catia. L5
2. Choose the correct module for the given sketch to design in catia. L6
3. List the steps required and draw the given component using catia. L4
4. From the given sketch make use of correct module and complete it. L3
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2. ANSYS



EXERCISE — 4

Determination of deflections and stresses in 2D truss

Obijective:
e To determine deflections and stresses in 2D truss using ansys software.

Out comes:

e Understand how to use ansys tools to analyse the given sketch.
e Understand the steps and menus used in ansys in various steps.

Scope of the experiment:

To provide an introduction to the use of ansys software in determining deflections and stresses
of 2D truss and experience them how to apply and where to apply the various loads.

Description of software:

The software used for doing this exercise is ansys apdl and it is developed by Ansys, Inc.
Regardless of the type of simulation, each model is represented by a powerful scripting language
... the Ansys Parametric Design Language (APDL). APDL is the foundation for all
sophisticated features, many of which are not exposed in the Workbench Mechanical user
interface. It also offers many conveniences such as parameterization, macros, branching and
looping, and complex math operations. All these benefits are accessible within the Ansys
Mechanical APDL user interface.
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FORCE AND STRESS ANALYSIS USING TWO LINK ELEMENTS IN TRUSSES

GENERAL STEPS

Step 1: Ansys Utility Menu

File — clear and start new — do not read file — ok
File — change job name — enter new job name — xxxx — ok

File — change title — enter new title — yyy — ok

Step 2: Ansys Main Menu — Preferences select - STRUCTURAL - ok

Step 3: Preprocessor

Element type — select type of element from the table and the required options

Real constants — give the details such as thickness, areas, moment of inertia, etc. required
depending on the nature of the problem.

Material Properties — give the details such as Young’s modulus, Poisson’s ratio etc.
depending on the nature of the problem.

Step 4: Modeling — create the required geometry such as nodes elements, area, and volume by
using

the appropriate options.

Step 5: Generate — Elements/ nodes using Mesh Tool if necessary (in 2D and 3D problems)

Step 6: Apply boundary conditions/loads such as DOF constraints, Force/Momentum,
Pressure etc.



Step 7: Solution — Solve the problem

Step 8: General Post Processor — plot / list the required results.

Step 9: Plot ctrls — animate — deformed shape — def+undeformed-ok

Step 10: to save the solution

PROCEDURE:

Ansys Main Menu — Preferences-select - STRUCTURAL- h method — ok

Element type — Add/Edit/Delete — Add — Link — 3D Finit stn 180 — ok — close.

Real constants — Add — ok — real constant set no — 1 — ¢/s area — 0.1 — ok — close.

Material Properties — material models — Structural — Linear — Elastic — Isotropic — EX

1. 210e9— Ok — close.

Modeling — Create — Nodes — In Active CS — Apply (first node is created) — x,y,z location in
CS— 0.75 (x value w.r.t first node) — apply (second node is created) — x,y,z location in CS —(o, -
0.5),(x, y value w.r.t first node) — ok (third node is created

Create—Elements—Elem Attributes — Material number — 1 — Real constant set number

1. 1—-o0k

Auto numbered — Thru Nodes — pick 1 & 2 — apply — pick 2 & 3—— ok (elements are created
through nodes).



8. Loads — Define loads — apply — Structural — Displacement — on Nodes — pick node 1 &3 —
apply — DOFs to be constrained — All DOF — ok

9. Loads — Define loads — apply — Structural — Force/Moment — on Nodes- pick node 2 — apply —
direction of For/Mom — FY — Force/Moment value — 5000 (-ve value)

10.  Solve — current LS — ok (Solution is done is displayed) — close.

11. Element table — Define table — Add —Results data item’ — By Sequence num — LS — LS1 — ok.

12.  Plot results — contour plot —Element table — item to be plotted LS,1, avg common nodes- yes
average- ok.

13. List Results — reaction solution — items to be listed — All items — ok (reaction forces will be
displayed with the node numbers).

14.  Plot results- nodal solution-ok-DOF solution- Y component of displacement-ok.

15.  Animation: PlotCtrls — Animate — Deformed shape — def+undeformed-ok.

CONCLUSION:

Thus the force and stress analysis of two link element in trusses is done by using the ANSYS

Software.



Additional Viva Questions:
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. How to import data in ansys from an external file.

. Write the function of preprocessor used in ansys.

. What is resume in ansys.

. List the steps involved in ansys.

. Can you tell how to import data from cad with an example.
. How to export data from ansys to cad.

. Write about p- method.

. What is optimization in ansys.

. How to display results in ansys.

10. Categorize the different menus in ansys.

Innovative Questions:
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How to open and save ansys apdl file?

Can we run apdl in ansys work bench .

On what machines ansys should be run.

Where can we use ansys apdl and workbench .
How to add noise to an image in ansys?

Tell about ansys application program software.
How do you make use of ansys function library?
Categorize the ansys menus used in various steps.

What type of programming language is ansys.

10. Where ansys can be applicable.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL

1. From the given sketch modify the boundaries and calculate deflections and L5
stresses.

2. Conclude the maximum stress and deflection from the given sketch. L6

3. Analyze the given sketch and generate results using ansys software. L4

4. From the given sketch how do you make use of ansys to determine stresses L3

and deflection.




EXERCISE —5

Determination of deflections and stresses in beams

Obijective:
e To determine deflections and stresses in beams using ansys software.

Out comes:

e Understand how to use ansys tools to analyse the given sketch.
e Understand the steps and menus used in ansys in various steps.

Scope of the experiment:

To provide an introduction to the use of ansys software in determining deflections and stresses
of beams and experience them how to apply the various loads.

Description of software:

The software used for doing this exercise is ansys apdl and it is developed by Ansys, Inc.
Regardless of the type of simulation, each model is represented by a powerful scripting language
... the Ansys Parametric Design Language (APDL). APDL is the foundation for all
sophisticated features, many of which are not exposed in the Workbench Mechanical user
interface. It also offers many conveniences such as parameterization, macros, branching and
looping, and complex math operations. All these benefits are accessible within the Ansys
Mechanical APDL user interface.
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STRESS AND DEFLECTION ANALYSIS IN CANTILEVER BEAM WITH POINT LOAD

GENERAL STEPS

Step 1: Ansys Utility Menu

File — clear and start new — do not read file — ok
File — change job name — enter new job name — xxxx — ok

File — change title — enter new title — yyy — ok

Step 2: Ansys Main Menu — Preferences select — STRUCTURAL - ok

Step 3: Preprocessor

Element type — select type of element from the table and the required options

Real constants — give the details such as thickness, areas, moment of inertia, etc. required
depending on the nature of the problem.

Material Properties — give the details such as Young’s modulus, Poisson’s ratio etc.
depending on the nature of the problem.

Step 4: Modeling — create the required geometry such as nodes elements, area, and volume by
using

the appropriate options.

Step 5: Generate — Elements/ nodes using Mesh Tool if necessary (in 2D and 3D problems)

Step 6: Apply boundary conditions/loads such as DOF constraints, Force/Momentum,
Pressure etc.



Step 7: Solution — Solve the problem

Step 8: General Post Processor — plot / list the required results.

Step 9: Plot ctrls — animate — deformed shape — def+undeformed-ok

Step 10: to save the solution

PROBLEM:

Compute the Shear force and bending moment diagrams for the beam shown and find the
maximum deflection. Assume rectangular c/s area of 0.2 m * 0.3 m, Young’s modulus of 210 GPa,
Poisson’s ratio 0.27.
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PROCEDURE:

1.

Ansys Main Menu — Preferences-Select - STRUCTURAL- h method — ok

Element type — Add/Edit/Delete — Add — BEAM — 2 node Beam 188 — ok- close.

Material Properties — material models — Structural — Linear — Elastic — Isotropic — EX

— 210e9— PRXY — 0.27 —ok — close.

Sections-Beams-common sections- sub type- rectangle (1t element) - enter b=200, h=300-
preview-ok.

Modeling — Create — Nodes — In Active CS — Apply (first node is created) — x,y,z location in
CS— 2 (x value w.r.t first node) — ok (second node is created).

Create — Elements — Auto numbered — Thru Nodes — pick 1 & 2 — ok (elements are created
through nodes).

Loads — Define loads — apply — Structural — Displacement — on Nodes- pick node 1 — apply —

DOFs to be constrained — ALL DOF - ok.

Loads — Define loads — apply — Structural — Force/Moment — on Nodes- pick node 2 — apply —
direction of For/Mom — FY — Force/Moment value —( -40000) (-ve value) — ok.

10. Solve — current LS — ok (Solution is done is displayed) — close.



11. Displacement: Plot Results — Contour plot — Nodal solution — DOF solution — displacement
vector sum — ok.

12. Stress: Plot Results — Contour plot — Nodal solution — stress — von mises stress — ok.

13. Element table — Define table — Add — ‘Results data item’ — By Sequence num — SMISC —
SMISC, 6 — apply, By Sequence num — SMISC — SMISC, 19 — apply, By Sequence num —
SMISC — SMISC, 3 — apply, By Sequence num — SMISC — SMISC, 16 — ok — close.

14. Plot results — contour plot — Line Element Results — Elem table item at node I — SMIS6 —
Elem table item at node J — SMIS19 — ok (Shear force diagram will be displayed).

15. Plot results — contour plot — Line Element Results — Elem table item at node I — SMIS3 —
Elem table item at node J — SMIS16 — ok (bending moment diagram will be displayed).

16. Reaction forces: List Results — reaction solution — items to be listed — All items — ok (reaction
forces will be displayed with the node numbers).

CONCLUSION:

Thus the stress and deflection analysis in cantilever beam with point load is done by using the
ANSYS Software.



Additional Viva Questions:
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. How to import file in ansys workbench from cad.

. Write the function of post processor used in ansys.
. What are different approximate solution methods .
. List the steps involved in FEA.

. Can you give example for higher order elements.

. How to obtain stiffness matrix.

. Write about h- method.

. What is stiffness matrix in ansys.

. How to identify order of elements.

10. Categorize the different menus in ansys workbench.

Innovative Questions:

© 0o N o g B~ wbh -

How to open and save ansys workbench file?

Can we open cad model in ansys and write its procedure.

On what machines ansys workbench should be run.

Where can we use ansys software in industries.

How to add noise to an image in ansys workbench?

Tell about ansys workbench application program software.
How do you make use of ansys workbench function library?
Categorize the ansys workbench menus used in various steps.

What type of programming language in ansys workbench is used.

10. Where ansys workbench can be applicable.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL

1. From the given sketch modify the boundaries and calculate deflections and L5
stresses.

2. Conclude the maximum stress and deflection from the given sketch. L6

3. Analyze the given sketch and generate results using ansys software. L4

4. From the given sketch how do you make use of ansys to determine stresses L3

and deflection.




Objective:

e To determine deflections and stresses in beams using ansys workbench software.

Out comes:

EXERCISE — 6

Determination of deflections and stresses in beams

e Understand how to use ansys tools to analyse the given sketch.
e Understand the steps and menus used in ansys in various steps.

Scope of the experiment:

To provide an introduction to the use of ansys software in determining deflections and stresses
of beams and experience them how to apply the various loads.

Description of software:

The software used for doing this exercise is ansys workbench and it is developed by Ansys, Inc.
Regardless of the type of simulation, each model is represented by a powerful scripting language

... the Ansys Parametric Design Language (APDL). ANSYS Workbench platform is the

backbone for delivering a comprehensive and integrated simulation. It is used to perform various
types of structural, thermal, fluid, and electromagnetic analyses.
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Given

Beam under 3-point bending with a centric applied force F as shown in Figure 1

Figure 1: Beam under 3-point bending.

Relevant geometrical and material data for our problem are given in Table 1:

F =500,000N Applied force
L =2,000mm Length of the beam
h =60mm Height of the beam cross section
t =20mm Thickness of the beam cross section
E =210,000 N/mm?2 |Young's modulus
v =03 Poisson’s ration
Oyield =235 N/mm? Allowable stress: yield stress of steel

Table 1: Geometry and material data.

Questions

1. Will the beam break and were would it start breaking?
2. Ifnot, what would be the maximum deflection w?



Procedure:

Preprocessor (Setting up the Model)
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Figure 5: Interface of ANSYS Workbench 14.0

Build the Geometry Using DesignModeler Module

To begin; drag the Static Structural Module from the Analysis Systems toolbox and
drop into the Project Schematic (Figure 6) and double click on the Geometry sub-
module to open the DesignModeler. When asked, choose the desired unit system.

Choose Create — Primitives — Box from the main menu to create a beam by entering
the desired dimensions in the Details box (Figure 7). Hit the Generate button to
actually create the geometry.

When specifying the dimension of the beam, make sure that the origin of the coordinate
system is located on the center of the beam’s cross section. The beam axis must be
oriented along the global x-axis.
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Figure 6: Drag-and-drop the Static Structural module to create a new analysis.
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Figure 7: The beam on the DesignModeler

Note that ANSYS Workbench saves the model automatically; you can simply close
DesignModeler now and continue with the next step.



Material Properties

i. Define Material Properties

Materials define the mechanical behavior of the FE model. We will use a simple linear-
elastic, isotropic material model. In the project schematic, right click on Engineering
Data to open a context menu and choose Edit... (Figure 8).
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Figure 8: Edit engineering data

Enter a name for your new material in row 4 (Figure 9).
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Figure 9: Naming the new material

Choose the simplest available material model by dragging the item Isotropic Elasticity
from the Toolbox and dropping it onto the row with your newly defined material
(Figure 10). Isotropic Elasticity requires certain material parameters: Young's
Modulus and Poisson’s Ratio.



After you entering the appropriate parameters do not forget to push Return to Project
button and to update the project
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Figure 10: Define the material properties.



Meshing

To mesh the solid body select double click the Model sub-module in the Project
schematic to open the Mechanical module (Figure 11).
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Figure 11: Starting the meshing and analysis module

Right click on Mesh in the Structure Tree and select a meshing method (Figure 12).
Mesh (right click) = Insert >Mapped Mesh
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Figure 12: Setup meshing details



At this point focus on the Details box and select the geometry (all 6 faces) and do not

forget to update the project; then click the Generate button.

0,000 0.2%0 0400 (m) ¢
0,100 0,300

Figure 13: Meshed body

Applying Loads and Boundary Conditions

i. Boundary Conditions

To setup the necessary support:
Structure Tree —> Static-Mechanic (right click) = Insert = Fixed Support

Select the Face you want to assign as a fixed support.
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Figure 14: Fixed Face of the body



ii. Applying the Loads

Structure Tree = Static-Mechanic (right click) > Insert > Force

Select the Face you want to assign a force on this surface.

Assign the components of the force vector. Now the problem is ready to be solved.
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Figure 15: Applied force
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Figure 16: Fixed face of the body and applied force



. Solving

To solve the problem add some solving tools to the Solution node which is part of the
Structure tree.

Solution (right click)-> Total Deformation

Solution (right click)—> Total Strain

Solution (right click)-> Total Stress

Solution (right click)—> Von-Mises Equivalent Stress

Click Solve
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Figure 17: Required solving tools

a. Contour Plot of Deformed Shape
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Figure 17: SCALED Displacement solution (z direction) of the beam (with too high force).



Additional Viva Questions:

. What is the total DOF of ansys commercial package.
. Write about workspace.

. What is swap face.

. List the scalar parameters in ansys.

. Can you give example for low order elements.

. How to obtain fine meshing in workbench.

. Write about primary nodes.

. What is mirror in ansys.

© o0 N o O ~h W N

. How to identify order of elements.
10. Categorize the different menus in ansys workbench.

Innovative Questions:

How to open geometry module in ansys workbench file?
Can we open cad model in ansys geometry directly.

On what machines ansys workbench 19.0 should be run.
Where can we use ansys 14.0 software in industries.

How to add noise to an image in ansys workbench 14.0?
Tell about ansys workbench application program software.
How do you make use of ansys workbench function library?

Categorize the ansys workbench menus used in various steps.

© oo N o g B~ wbh -

What type of programming language in ansys workbench 19.0 is used.

10. Where ansys workbench can be applicable.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL

1. From the given sketch modify the boundaries and calculate deflections and L5
stresses.

2. Conclude the maximum stress and deflection from the given sketch. L6

3. Analyze the given sketch and generate results using ansys software. L4

4. From the given sketch how do you make use of ansys to determine stresses L3

and deflection.




EXERCISE —7

Harmonic analysis

Obijective:

e To perform harmonic analysis for the given beam.

Out comes:

e Understand how to use ansys tools to analyse the given beam.
e Understand the steps and menus used in ansys in various steps.

Scope of the experiment:

To provide an introduction to the use of ansys software in performing harmonic analysis on the
given beam using full method.

Description of software:

The software used for doing this exercise is ansys apdl and it is developed by Ansys, Inc.
Regardless of the type of simulation, each model is represented by a powerful scripting language
... the Ansys Parametric Design Language (APDL). APDL is the foundation for all
sophisticated features, many of which are not exposed in the Workbench Mechanical user
interface. It also offers many conveniences such as parameterization, macros, branching and
looping, and complex math operations. All these benefits are accessible within the Ansys
Mechanical APDL user interface.

A\ ANSYS Academic Research Utility Menu = o |
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= Solution =) f&l
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b
l

Pick a menu item or enter a command (BEGIN) | mat=1 | type=1 , real=1 [ CcSsys




STRESS AND DEFLECTION ANALYSIS IN SIMPLY SUPPORTED BEAM
WITH POINT LOAD

PROCEDURE:

=

Ansys Main Menu — Preferences-Select — STRUCTURAL- h method — ok

Element type — Add/Edit/Delete — Add — BEAM — 2 node BEAM 188- ok- close.

Material Properties — material models — Structural — Linear — Elastic — Isotropic — EX

— 2.10e5— PRXY — 0.27 — ok — close.

Sections-Beams-common sections- sub type- rectangle (1t element) -enter b=100, h=100-
preview-ok.

Modeling — Create — Nodes — In Active CS — Apply (first node is created) — x,y,z location in
CS— 1000 (x value w.r.t first node) — apply (second node is created) — 2500 (x value w.r.t first
node) — apply(third node is created)- x,y,z location in CS-3500 (x value w.r.t first node)-ok.

Create — Elements — Auto numbered — Thru Nodes — pick 1 & 2 apply — pick 2 & 3 apply — pick
3 & 4 — ok (elements are created through nodes).

Loads — Define loads — apply — Structural — Displacement — on Nodes- pick node 1 & 4 — apply
—DOFs to be constrained — all DOF - ok.

Loads — Define loads — apply — Structural — Force/Moment — on Nodes- pick node 2 — apply —
direction of For/Mom — FY — Force/Moment value — -2000(-ve value) — ok-Force/Moment —



on Nodes- pick node 3 — apply —direction of For/Mom — FY — Force/Moment value — -4000(-
ve value) — ok.

9. Solve — current LS — ok (Solution is done is displayed) — close.

10. Displacement: Plot Results — Contour plot — Nodal solution — DOF solution — displacement
vector sum — ok.

11. Stress: Plot Results — Contour plot — Nodal solution — stress — vonmises stress — ok.

12. Element table — Define table — Add — ‘Results data item’ — By Sequence num — SMISC —
SMISC, 6 — apply, By Sequence num — SMISC — SMISC, 19 — apply, By Sequence num —
SMISC — SMISC, 3 — apply, By Sequence num — SMISC — SMISC, 16 — ok — close.

13. Plot results — contour plot — Line Element Results — Elem table item at node I — SMIS6 — Elem
table item at node J — SMIS19 — ok (Shear force diagram will be displayed).

14. Plot results — contour plot — Line Element Results — Elem table item at node I — SMIS3 — Elem
table item at node J — SMIS16 — ok (bending moment diagram will be displayed).

15. Reaction forces: List Results — reaction solution — items to be listed — All items — ok (reaction
forces will be displayed with the node numbers).

NOTE: For Shear Force Diagram use the combination SMISC 6 & SMISC 19, for Bending Moment
Diagram use the combination SMISC 3 & SMISC 16.

16. Animation: PlotCtrls — Animate — Deformed results — DOF solution — USUM - ok.

RESULT:

Thus the stress and deflection analysis in simply supported beam with point load is done by
using the ANSYS Software.
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Additional Viva Questions:

1.Define term node.

. Write about element.

. What is convergence.

. List types of convergence used in ansys.

. Can you tell use of geometric invariance in ansys.

. How do we use pascal triangle in FEA.

. Write about connectivity.

. What are the methods to improve problem solution.

© 0O ~N o o B~ W DN

. Define plane stress.
10. What is plane strain.

Innovative Questions:

Compare FEA with solid mechanics.

Write the packages available for FEA.

On what machines FEA packages should be run.
Where can we use model of physical system.

List the properties of shape function.

Tell about different coordinates involved in chain rule.
How do you make use of galerkin method in FEA?

Categorize the ansys procedure in doing FEA.

© o N o g B~ wDdPE

What type of programming language is NASTRAN.

10. Where weighted residual methods can be applicable.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL
1. From the given sketch modify the boundaries and perform harmonic analysis. | L5
2. Conclude the amplitude and frequency from the given beam. L6
3. Analyze the given sketch and generate results using ansys software. L4
4, From the given sketch how do you make use of ansys to perform harmonic L3

analysis.




EXERCISE — 8

Modal analysis

Obijective:

e To perform modal analysis for the given beam.

Out comes:

e Understand how to use ansys tools to analyse the given beam.
e Understand the steps and menus used in ansys in various steps.

Scope of the experiment:

To provide an introduction to the use of ansys software in performing modal analysis on the
given beam using full method.

Description of software:

The software used for doing this exercise is ansys apdl and it is developed by Ansys, Inc.
Regardless of the type of simulation, each model is represented by a powerful scripting language
... the Ansys Parametric Design Language (APDL). APDL is the foundation for all
sophisticated features, many of which are not exposed in the Workbench Mechanical user
interface. It also offers many conveniences such as parameterization, macros, branching and
looping, and complex math operations. All these benefits are accessible within the Ansys
Mechanical APDL user interface.

A\ ANSYS Academic Research Utility Menu = o |

Eile Select List Plot PilotCtris WorkPlane Parameters Macro MenpuCitris Help
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Toolbar i1
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Pick a menu item or enter a command (BEGIN) | mat=1 | type=1 , real=1 [ CcSsys




MODEL ANALYSIS OF CANTILEVER BEAM WITHOUT LOAD

To perform a Model Analysis of Cantilever beam without load using analysis software ANSYS.

I0.0I m

0.01 ;n

1m

A
A

PROBLEM DESCRIPTION:

Model Analysis of Cantilever beam for natural frequency determination.

Modulus of elasticity = 200GPa, Density = 7800 Kg/m3.



+ Modal Analysis

As shown, select the Subspace method and enter 5 in the 'No. of modes to extract'

Check the box beside 'Expand mode shapes' and enter 5 in the 'No. of modes to expand'

Click 'OK'

Note that the default mode extraction method chosen is the Reduced Method. This is the fastest
method as it reduces the system matrices to only consider the Master Degrees of Freedom (see
below). The Subspace Method extracts modes for all DOF's. It is therefore more exact but, it also
takes longer to compute (especially when the complex geometries).

The following window will then appear



: Subspace Modal Analysis

At zhift+end pts =

For a better understanding of these options see the Commands manual.
o For this problem, we will use the default options so click on OK.

3. Apply Constraints
Solution > Define Loads > Apply > Structural > Displacement > On Keypoints

Fix Keypoint 1 (ie all DOFs constrained).

4. Solve the System

Solution > Solve > Current LS
SOLVE

Postprocessing: Viewing the Results
1. Verify extracted modes against theoretical predictions
o Select: General Postproc > Results Summary...

The following window will appear
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The following table compares the mode frequencies in Hz predicted by theory and ANSYSS.

Mode || Theory || ANSYS || Percent Error
1 8.311 || 8.300 0.1
2 51.94 || 52.01 0.2
3 145.68 || 145.64 0.0
4 285.69 || 285.51 0.0
5 472.22 || 472.54 0.1

Note: To obtain accurate higher mode frequencies, this mesh would have to be refined even more
(i.e. instead of 10 elements, we would have to model the cantilever using 15 or more elements
depending upon the highest mode frequency of interest).
2. View Mode Shapes
o Select: General Postproc > Read Results > First Set
This selects the results for the first mode shape
o Select General Postproc > Plot Results > Deformed shape . Select 'Def + undef edge'

The first mode shape will now appear in the graphics window.

o To view the next mode shape, select General Postproc > Read Results > Next Set . As above
choose General Postproc > Plot Results > Deformed shape . Select 'Def + undef edge'.

o The first four mode shapes should look like the following:
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3. Animate Mode Shapes

o Select Utility Menu (Menu at the top) > Plot Ctrls > Animate > Mode Shape

The following window will appear

: Animate Mode Shape E
Animation data

Ho. of Frames to create |1B
Time delay <{seconds? |ﬂ.5

Aceeleration Tvpe
+ Linear
 Binusoidal

Hodal Solution Data
Dizplay Tupe

Def + wndeformed

Strain-total Def + undef edge
Energy Transzlation s
Strain—-elastic uy
Strain-thermal uE
Strain-plastie USUH *
Strain-cres

Srrain—nthe£ = | |[Deformed Shape

oK Cancel Help |

o Keep the default setting and click 'OK’
o The animated mode shapes are shown below.
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Additional Viva Questions:
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. Define term element.

. Write about node.

. What is beam.

. List types of beams used in ansys.

. Can you tell use of beam analysis in ansys.

. How do we use modal analysis in analyzing beams.
. Write about cantilever beam.

. What are the different loads acting on beam.

. Define truss.

10. What is simply supported beam.

Innovative Questions:
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Compare FEA with experimental method.

Write the packages available for FEA.

On what processors FEA packages should be run.
Where can we use modal analysis results of beam.

List the types of shape function.

Tell about principal of virtual work.

How do you make use of virtual displacement in FEA?
Categorize the advantages in doing FEA.

What type of programming language is IDEAS.

10.Specify the terms required to solve FEA problem.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL
1. From the given sketch modify the boundaries and perform modal analysis. L5
2. Determine the number of mode shapes from the given beam. L6
3. Analyze the given sketch and generate results using ansys software. L4
4, From the given sketch how do you make use of ansys to perform modal L3

analysis.




EXERCISE —9

Thermal analysis

Obijective:
e To perform heat transfer analysis for the given object.

Out comes:

e Understand how to use ansys tools to analyse the heat transfer analysis.
e Understand the steps and menus used in ansys in various steps.

Scope of the experiment:

To provide an introduction to the use of ansys software in performing thermal analysis on the
given object using conduction.

Description of software:

The software used for doing this exercise is ansys apdl and it is developed by Ansys, Inc.
Regardless of the type of simulation, each model is represented by a powerful scripting language
... the Ansys Parametric Design Language (APDL). APDL is the foundation for all
sophisticated features, many of which are not exposed in the Workbench Mechanical user
interface. It also offers many conveniences such as parameterization, macros, branching and
looping, and complex math operations. All these benefits are accessible within the Ansys
Mechanical APDL user interface.
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Pick a menu item or enter a command (BEGIN) | mat=1 | type=1 , real=1 [ CcSsys




THERMAL STRESS ANALYSIS WITHIN THE RECTANGULAR PLATE

To perform a thermal stress analysis of a rectangular plate using analysis software ANSYS.

PROBLEM DESCRIPTION:

2-D heat conduction problem for the temperature distribution within the rectangular plate.
Thermal conductivity of the plate, KXX=401 W/(m-K).

PROCEDURE:

1. Ansys Main Menu — Preferences-select - THERMAL- h method- ok

2. Element type — Add/Edit/Delete — Add — Solid — Quad 4 node — 55 — ok — option —
elementbehavior K3 — Plane stress with thickness — ok — close.

3. Material Properties — material models — Thermal — Conductivity — Isotropic — KXX — 401.

4. Modeling — Create — Area — Rectangle — by dimensions — X1, X2, Y1, Y2 — 0, 10, 0, 20 — ok.



5. Meshing — Mesh Tool — Mesh Areas — Quad — Free — Mesh — pick all — ok. Mesh Tool — Refine
— pick all — Level of refinement — 3 — ok.

6. Loads — Define loads — apply — Thermal — Temperature — on Lines — select 1000 C lines —
apply — DOFs to be constrained — TEMP — Temp value — 1000 C — ok.

7. Loads — Define loads — apply — Thermal — Temperature — on Lines — select 1000 C lines —

8. Solve — current LS — ok (Solution is done is displayed) — close.

9. Read results-last set-ok

10. List results-nodal solution-select temperature-ok

11. Observe the nodal solution per node.

12. From the menu bar-plot ctrls-style-size and shape-display of the element-click on real constant
multiplier=0.2, don’t change other values-ok.

13. Plot results-contour plot-nodal solution-temperature-deformed shape only-ok

14. Element table-define table-add-enter user label item=HTRANS, select by sequence no SMISC,
1-ok-close.

15. Element table-list table-select HTRANS-ok

conclusion

Thus the thermal stress analysis of a rectangular plate is done by using the ANSYS Software.



Additional Viva Questions:
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. Define conduction.

. Write about convection.

. What are types of shape function.

. List types of elastic constants used in ansys.

. Can you tell use of young’s modulus and poisson’s ratio in ansys.
. How do we use thermal analysis in heat transfer applications.

. Write about radiation.

. What are the different modes of heat transfer.

. Define heat.

10. What is Stefan boltzman constant.

Innovative Questions:
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Compare FEA with therotical method.

Write the packages available for FEA thermal analysis.

On what processors thermal analysis should be run.

Where can we use thermal analysis results in heat transfer applications.
List the types of thermal analysis.

Tell about transient thermal analysis.

How do you make use of virtual displacement in FEA?

Categorize the advantages of thermal analysis in doing fluent.

What type of programming language is fluent.

10. Specify the terms required to solve thermal problems.



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL
1. From the given object apply the boundaries and perform thermal analysis. L5
2. Write your opinion in conducting thermal analysis in convection mode. L6
3. Analyze the given sketch and generate results using ansys software. L4
4, From the given sketch how do you make use of ansys to perform thermal L3

analysis.
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Introduction

The term numerical control is a widely accepted and commonly used term in the machine
tool industry. Numerical control (NC) enables an operator to communicate with machine tools
through a series of numbers and symbols. NC which quickly became Computer Numerical Control
(CNC) has brought tremendous changes to the metalworking industry. New machine tools in CNC
have enabled industry to consistently produce parts to accuracies undreamed of only a few years
ago. The same part can be reproduced to the same degree of accuracy any number of times if the
CNC program has been properly pre- pared and the computer properly programmed. The
operating commands which control the machine tool are executed automati- cally with amazing
speed, accuracy, efficiency, and repeatability.

The ever-increasing use of CNC in industry has created a need for
personnel who are knowledgeable about and capable of preparing the programs which guide the
machine tools to produce parts to the required shape and accuracy. With this in mind, the
authors have prepared this textbook to take the mystery out of CNC - toput it into a logical
sequence and express it in simple language that everyone can understand. The preparation of a
program is explained in a logical step-by-step procedure, with practical ex- amples to guide the
student. Almost everything that can be produced on a conventional ma- chine tool can be
produced on a computer numerical control machine tool, with its many advantages. The machine
tool move- ments used in producing a product are of two basic types: point- to-point (straight-
line movements) and continuous path (contouring movements).

The Cartesian, or rectangular, coordinate system was devised by the
French mathematician and philosopher Rene’ Descartes. With this system, any specific point can
be described in mathematical terms from any other point along three perpendicular axes. This
concept fits machine tools perfectly since their construction is generally based on three axes of
motion (X, Y, Z) plus an axis of rotation. On a plain vertical milling machine, the X axis is the
horizontal movement (right or left) of the table, the Y axis is the table cross movement (toward or
away from the column), and the Z axis is the vertical movement of the knee or the spindle. CNC
systems rely heavily on the use of rectangular coordinates be- cause the programmer can locate
every point on a job precisely.
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Block of Information:

CNC information is generally programmed in blocks of five words. Each word conforms to the EIA
standards and they are written on a horizontal line. If five complete words are not included in
each block, the machine control unit (MCU) will not recognize the information, therefore the
control unit will not be activated.




Machines Using CNC

Early machine tools were designed so that the operator was standing in front of the machine while
operating the controls. This design is no longer necessary, since in CNC the operator nolonger
controls the machine tool movements. On conventional machine tools, only about 20 percent of
the time was spent remov- ing material. With the addition of electronic controls, actual time spent
removing metal has increased to 80 percent and even higher. It has also reduced the amount of
time required to bringthe cutting tool into each machining position.

Machine types
Lathe

The engine lathe, one of the most productive machine tools, has always been an efficient means of
producing round parts. Most lathes are programmed on two axes.

The X axis controls the cross motion of the cutting tool

Negative X (X-) moves the tool towards the spindle centerline; positive X moves the tool away from
the spindle centerline.

The Z axis controls the carriage travel toward or away from the headstock.

Milling Machine

The milling machine has always been one of the most versatile machine tools used in industry
Operations such as milling, contouring, gear cutting, drilling, boring, and reaming are only a few
of the many operations which can be performed on a milling machine. The milling machine can be
programmed on three axes:

The X axis controls the table movement left or right.
The Y axis controls the table movement toward or away from the column.
The Z axis controls the vertical (up or down) movement of the knee or spindle.




X AXIS

Programming Systems

Two types of programming modes, the incremental system and the absolute system, are used for
CNC. Both systems have applications in CNC programming, and no system is either right or wrong
all the time. Most controls on machine tools today are capable of handling either incremental or
absolute programming.

Incremental program locations are always given as the distance and direction from the
immediately preceding point. Command codes which tell the machine to move the table, spindle,
and knee are explained here using a vertical milling machine. as an example:

| |
I- 750 —wje- 750 - .750;-'

A “X plus” (X+) command will cause the cutting tool to be located to the right of the last point.
A “X plus” (X-) command will cause the cutting tool to be located to the right of the last point.
A Y plus” (Y+) command will cause the cutting tool to be located toward the column.
A “Y minus” (Y-) will cause the cutting tool to be located away from the column.

A “Z plus” (Z+) command will cause the cutting tool or spindle to move up or away from
the workpiece.




*A “Z minus” (Z-) moves the cutting tool down or into the work- piece.
In incremental programming, the G91 command indicates to the computer and MCU
(Machine Control Unit) that programming is in the incremental mode.

Absolute program locations are always given from a single fixed zero or origin point (Fig.
. The zero or origin point may be a position on the machine table, such as the corner of
the worktable or at any specific point on the workpiece. In absolute dimensioning and
programming, each point or location on the workpiece is given as a certain distance from

the zero or reference point.
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A “X plus” (X+) command will cause the cutting tool to be located to the right of the

zero or origin point.
A “X'minus” (X-) command will cause the cutting tool to be located to the left of the

zero or origin point.
A “Y plus” (Y+) command will cause the cutting tool to be located toward the

column.
A “Y minus” (Y-) command will cause the cutting tool to be located away from the

column.

In absolute programming, the G90 command indicates to the computer and MCU that the
programming is in the absolute mode.




EXERCISE - 10

Development of NC code

Objective:
e To develop a NC code for given part manually and check using cam software.
Out comes:

e Understand how to write CNC code for basic process like turning, milling.
e Understand the steps and codes used to write a program.

Scope of the experiment:
To provide an introduction to develop NC code for given part manually.

Description of software:

The software used for doing this exercise is fusion 360 and it is developed by Autodesk. Fusion
360 is a cloud-based CAD/CAM tool for collaborative product development. Fusion 360 enables
exploration and iteration on product ideas and collaboration within distributed product
development team. Fusion 360 combines organic shapes modelling, mechanical design and
manufacturing in one comprehensive package.
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CNC Programming
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To cancel any previous working zero point

N0010 Sequence number
T0404 Select tool number 404

G57 To set the working zero point as saved
GO0 Rapid movement (no cutting)

X26.0 X location (as a diameter; 13 form zero)
Z20.0 Z location

S500 Spindle speed is 500 rpm

MO04 Rotate spindle counterclockwise

GO1 Linear interpolation (cutting)

X-0.20 Move only in x direction until you pass
the center by 0.1 mm (facing)

F100 Set feed rate to 100 mm/min.

G00 Move rapidly away from work piece (no cutting)
Z22.0 the movement is 2 mm away from the face.

Go to a safe location away from the workpiece [x = 50
(25 from zero), z = 50] to change the tool.

T0404 Select tool number 404



G57 PSO

GO0 Rapid movement (no cutting)

X22.50 X location (as a diameter; 11.25 form zero)
Z2.0 Z location

S$500 Spindle speed is 500 rpm

GO1 Linear interpolation (cutting)
Z-30 Move only in z direction (external turning)
F100 Set feed rate to 100 mm/min.

G00 Move rapidly away from work piece (no cutting) to location x= 23.0
(11.50 from zero) and z = 2.0.

G84 Turning cycle for machining the step
X17.5 final diameter
Z-20 length of step is 20 mm
_ D0=200 Finish allowance in X direction (0.2
e mm) D2=200 Finish allowance in Z direction
(0.2 mm)
D3=650 Depth of cut in each pass (0.65 mm)

G00 Move rapidly away from workpiece (no cutting)
Z22.0 the movement is 2 mm away from the face.

X50.0 Z50.0 Move to the tool changing location
M30 Program End



Additional Viva Questions:

. How to import data in fusion 360 from an external file.

. Write the function of import data forms used in fusion 360.

. What are the 2D turning operations available in fusion 360.

. List the 2D milling operations available in fusion 360.

. Can you tell how to import CAD data into cam module with an example.
. How to export data from fusion 360 to NC machine.

. Write the procedure to export NC code from fusion 360.

. What are the steps required to do simple turning in fusion 360.
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. How to do simulation in fusion 360.
10. Categorize the tool paths provided in fusion 360.

Innovative Questions:

How to call cam module in fusion 360?

Can we open igs file in fusion 360 if so how ?

On what machines fusion 360 should be run.

Where can we use fusion 360 for?

How to add noise to a simulation in fusion 360?

Tell about fusion 360 applications.

How do you make use of fusion 360 in manufacturing industry.

Categorize the cam process used in fusion 360.
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What type of programming language is used in fusion 360.

10. Where fusion 360 software can be applicable



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL
1. Using fusion 360 software generate a NC code for the given part. L5
2. Create a NC code for the given part using cam software. L6
3. List the cam procedure used in fusion 360 to generate NC code for given part. | L4
4. For the given part how do you make use of fusion 360 for doing cam. L3




EXERCISE —11
CNC PROGRAMMING using Fusion 360

Obijective:
e Todevelop a CNC code for the given simple part.
Out comes:

e Understand how to write CNC code for basic process like turning, milling.
e Understand the steps and codes used to write a program.

Scope of the experiment:

To provide an introduction to the use of cam software in developing NC code for given part

Description of software:

The software used for doing this exercise is fusion 360 and it is developed by Autodesk. Fusion
360 is a cloud-based CAD/CAM tool for collaborative product development. Fusion 360 enables
exploration and iteration on product ideas and collaboration within distributed product
development team. Fusion 360 combines organic shapes modelling, mechanical design and
manufacturing in one comprehensive package.
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Procedure :

CAD Modeling in Autodesk Fusion 360

1.

Start Autodesk Fusion 360, a new file
'‘Untitled" will be created
automatically. Save it in a project

I

WSSEMBLE =

—_—
=

INSPECT

{{%] Create Sketch

Draw the 2D geometry of the part.

Use the drawing tools in the
'SKETCH' menu.

When the sketch is done, return to 3D
view by clicking 'STOP SKETCH'.

{9 create sketch

Rectangle
e N
Arc
Polygon

@ Elipse
Shot

J spine

£\ Conic curve

-4~ Point

A Text

{+ Fillet

/- Trim T

-/ Extend

|- Break

AL Offset o

DIg Mirror

b Circular Pattern

370 Rectangular Pattern

Project / Inciude

&3 stop Sketch

CONSTRUCT v INSPECT v

- Line L

|| Sketch Dimension D

7t = o C
folder and give it a describing name. 5 Line b
Create a new sketch and select the Rectangle >
plane to draw it in. Circle 3
o> MW = G

INSERTY MAKEv  ADD-INS~v SELECT v STOP SKETCH

P @ center Diameter Circle C
¥ @ 2-point Circle

50

{&)} 2-Tangent Circle
Q) 3-Tangent Circle

»

Use the tools in the '"MODIFY' menu
to pull the sketch into a 3D geometry
and modify it.

Press Pull = Raise 2D into 3D

Chamfer = Create a chamfered edge

Fillet = Create an edge with a radius

mﬁp

ASSEMBLE ¥

@ Press Pull

—
[t

[y

SKETCH~¥  CONSTRUCT v INSPECT INSERTY  MAKE ¥

Q

(D Fillet

€D Rule Fillet
@ Chamfer

F

Shel

@ Draft

E‘ Scale

Q Combine

[ Replace Face
@ Spiit Face

{9 spit Body

€ sihouette Spiit

0§¢ Move

B8 aiign

Physical Material

@ Appearance

Manage Materials

A

E;" Delete
E'; Compute All

E Change Parameters

Del
Ctr+B
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4 Create additional sketches if m:= x
) necessary. Modify them into 3D o
geometry. : S
CAM Process in Autodesk Fusion 360
.I
1 Select CAM mode. ” C1] g
CRI

[_"-J':"|| MODEL

S| PATCH

RENDER

ANIMATION
r/]h] SIM

—éﬂ,ﬁ‘“"‘b

2 Create a new setup. = Z (5 ‘2”‘ - El

3Dv DRILLING TURNING v ACTIONS ¥

Setup

Select the origin point under the

1| B3 New Folder Defines a number of general properties for a set of
machining operations.
ISetup' tab ] B New Pattern
You can specify the Work Coordinate System (WCS),
nits: mm stock geometry, fictures, and machining surfaces.

Specify the stock material shape and | ;eaions
size under the 'Stock'’ tab.




Create the necessary cutting
operations.

Choose the cutting operation from the
2D menu.

Select the cutting tool to be used.

Fill in the Spindle Speed, Ramp
Spindle Speed, Cutting Feedrate,
Lead-In Feedrate, Lead-Out
Feedrate, Ramp Feedrate and
Plunge Feedrate according to the
Speeds and Feeds Table.

Select the geometry to be cut.

Select the heights of the depth of the
cut.

Select the depth per pass under
'Passes' tab.

Keep in mind how the part should
be fixtured / clamped to the table. It
is common to machine it halfway
and then flip it around in order to
machine the second half.

I—gl 2D CONTOUR : 2D CONTOUR1

@ Tool @ Geometry | 7 Heights E] Passes

¥ Tool

Tool

Coolant

¥ Feed & Speed
Spindie Speed
Surface Speed
Ramp Spindle Speed
Cutting Feedrate
Feed per Tooth
Lead-In Feedrate
Lead-Out Feedrate
Ramp Feedrate
Plunge Feedrate

Feed per Revolution

Select...

#1 - 8 mm flat

Flood

g Linking

[1200

[30.1593 m/min

[1200 rpm

[190

[0.0791667 mm

[190

[190

[190

[190]

[0.158333 mm

CK

Cancel

4ar 4 4

4ar 4 4




Simulate to make sure that the
toolpaths are correct.

v ACTIONS

.

o) L

Generate the G -Code by selecting
‘Post Process'

Select 'mach3mill.cps' under 'Post
Configuration’

Give the program a name under
'Program name or number

Hit OK , save the file and head to the
CNC Mill!

Post Process

Configuration Folder
l »duction\4985426b55f0976 109b4ac17335cfe Se 17f5b 1cf\Applications\CAM360\Data\Posts |... Setup
Post Configuration
mach3mill.cps - Generic Mach3Mill Al v Open config
Output folder NC extension
[ C:\Users\Viktor\Desktop | | .tap Open folder
Program Settings
Program name or number
Property Value
| Exempel |
(Built-in) allowHelicalMoves Yes

Program comment (Built-in) highFeedMapping
l | (Built-in) highFeedrate

Preserve rapi...
0

(Built-in) maximumCircularRadius 1000

Unit (Built-in) minimumChordLength 0.01
Document unit ~ (Built-in) minimumCircularRadius 0.01

(Built-in) tolerance 0.002
[CJReorder to minimize tool changes dwelllnSeconds Yes
[[]Open NC file in editor optionaistop yes

preloadTool No

Cancel




Additional Viva Questions:

. How to import data in fusion 360 from an external file.

. Write the function of import data forms used in fusion 360.

. What are the 2D turning operations available in fusion 360.

. List the 2D milling operations available in fusion 360.

. Can you tell how to import CAD data into cam module with an example.
. How to export data from fusion 360 to NC machine.

. Write the procedure to export NC code from fusion 360.

. What are the steps required to do simple turning in fusion 360.
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. How to do simulation in fusion 360.
10. Categorize the tool paths provided in fusion 360.

Innovative Questions:

How to call cam module in fusion 360?

Can we open igs file in fusion 360 if so how ?

On what machines fusion 360 should be run.

Where can we use fusion 360 for?

How to add noise to a simulation in fusion 360?

Tell about fusion 360 applications.

How do you make use of fusion 360 in manufacturing industry.

Categorize the cam process used in fusion 360.
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What type of programming language is used in fusion 360.

10. Where fusion 360 software can be applicable



Blooms Taxonomy questions for mid/End exam.

S.NO. QUESTION LEVEL
1. Using fusion 360 software generate a NC code for the given part. L5
2. Create a NC code for the given part using cam software. L6
3. List the cam procedure used in fusion 360 to generate NC code for given part. | L4
4. For the given part how do you make use of fusion 360 for doing cam. L3




COMPUTER AIDED MODELING AND ANALYSIS LAB
VIVA QUESTIONS

What is the total degree of freedom of Ansys commercial package.
What are the different menus in ANSYS.

What is Work space and Swap space.

What is default value of worksplace and Swapspace?
What file format ANSY'S can support

What is the current ANSYS version

What is optimization in ANSYS.

What is sub structuring and adaptive meshing.

. Which package is better — ANSYS or NASTRAN.
10.What is Resume in ANSYS.

11.What is P-method and H-method

12.What is scalar parameters in ANSYS.

13. What are primary nodes and Secondary nodes.

14. What is Mirror ( Reflection).

15. What is subroutines.

VO NGO R WDNRE

VIVA QUESTIONS ON FEM

What are the different approximate solution methods.
Different approximate solution methods are
1.Functional approximation
2.Finite Difference method
3. Finite Element method

What do you mean by continuum.
Structure which is considered for analysis is called continuum.

Define term node
The element which is connected with another element at junction is called node.

Define term element
Descritised structure is called an element .

What is convergence
Process of achieving value to actual solution.

What are the types convergence
p-convergence
h-convergence

What is p- convergence
Convergence by increasing the
elements



What is h convergence
Convergence by increasing
nodes

What is higher order elements
The element which contain more no. of nodes are called higher order element .

Give example for higher order elements
Higher order elements are CST, Quadrilateral element.

What do you mean by compatible elements.
Elements, which are compatible with adjacent element, like no discontinuity, overlap or
sudden slope.

What is geometric invariance.
The property in which the shape of the element will not change with change in local
coordinates is called geometric invariance.

Why do we use Pascal’s triangle in FEA
If the displacement equation doesn’t contain all the required terms then balancing is done by
the Pascal’s triangle.

What are the steps involved in FEA
Steps involved in FEA:
1.Modelling
2.Descritization of structure
3.Derivation of elemental stiffness matrix.
4.Assembly of elemental equation
5.Applying boundary conditions
6.Computation of stress and strain
7.Interpretaion of results

what is stiffness matrix
The matrix when contain parameters like E, A, displacement and applied force is stiffness
matrix

.Q16) How to obtain stiffness matrix
Stiffness matrix can be obtained by applying condition of minimum potential energy to
potential energy equation.

What is displacement function
. Displacement function is the assumed polynomial equation, which satisfies boundary
conditions.

How to identify order of elements
Order of elements depends on the no. of nodes.

Mention different types of elements
Different types of elements are bar elements, beam element, truss element, shell element, axis
symmetric.



Mention some application of FEA
Mechanical, Aerospace, Civil, structure analysis, biomedical, geo -mechanic,
electromagnetic.

What is connectivity.
Relation between the connected elements is connectivity.

What are the methods to improve problem solution
Problem solution can be improved by increasing no. of elements or no. of nodes .

Define symmetry in matrix
It is the square matrix in which the element of the row are same as that of element of column.

What is plane stress Stress
acting on 2-D element.

What is plane strain Strain
occurring in 2-D element.

Compare FEA with solid mechanics
complicated irregular structures are difficult in solid mechanics but FEA it’s easier with
greater accuracy.

What are the packages available for FEA
packages available for FEA: ANSYS, I-DEAS,NASTRAN,ABAQUS,
COSMOS,ALGOL,PATRAN.

Define potential energy
Energy possessed by the body due to it’s position

Define minimum potential energy
for consertive system of all kinematically admissible displacement field those corresponding
to equilibrium extremise the total potential energy if extreme condition is a minimum the
equilibrium state is stable

Write potential energy equation for cantilever beam
I1= EI/2 | (d2y/dx2) dx — pie

Mention 2 different methods to approach the model of physical system .
Discrete system , continuum

Difference between global co ordinate and local co ordinate

Global co-ordinate Local co ordinate
1.Contain 2 degrees of freedom Contain 1 degrees of freedom
2. Represented without prime Represented with prime

3. Systematic schemes are used | No schemes are used

What is local coordinate



local coordinate contains 1-D.O.F. at each node.

What is global co ordinate
Global coordinate contains 2-D.O.F. at each node.

General assumption made in stress

Assumptions:

1.Truss elements are connected by fracture less pin.
2.Load is applied on the load.

3.0nly two forces compressive and tensile are considered.

What is shape function
It is mathematical polynomial, which gives displacement within the element.

What are two general natural coordinate Two
general co-ordinates are n(eeta) and zeeta.

Mention the range of natural co-ordinate Range of
natural coordinatesis —0to 1 and-1to 1.

Number of shape function in CST Number
of shape function in CST are three.

Number of shape function in quadrilateral
Number of shape function in quadrilateral are 4.

Why we are using natural integration
we are using natural integration to simplify the problem.

Explain one point formula
1-point shape function contains one term [f(x)dx=w.f(x)

Explain two point formula
2-point shape function contains two term [f(x).dx=w1f(x1) w2f(x2)

Why we are using polynomial equation in FEA
Polynomial equation gives continuous solution & it is simple to solve problem.

What are the two important characteristics in stiffness matrix
Characteristics of stiffness matrix is symmetric and bonded

Mention two schemes to represent band width2-
Schemes are

Horizontal numbering

Vertical numbering

What are forces involved in work potential
Forces involved are Body force, Traction force and Point force

Q.48)What are the different methods to apply boundary condition



Elimination, multiconstraint, penalty method

What is isoparametric elements
These are those the S.F. used to define variables of displacement equal to S.F. used to
represent geometry.

What is orthotropic elements
Material which has three orthogonal planes of symmetry said to be orthotropic elements.
Only nine constants are required to describe constituent equation

What is anisotropic elements
The material which doesn’t contain any plane of symmetry

What is isotropic elements
isotropic material is one in which every plane is plane of symmetry only two constants are
enough to describe constituent equation

What is super parametric elements
GSF > DSF (geometric shape function, displacement shape function
Q.54) What is sub parametric elements
GSF < DSF

Different coordinates involved in chain rule.
Different coordinates involved in chain rule are normal , local and displacement coordinates .

What are the 2 different approaches to study elasticity ?
Strength of material , Theory of elasticity

Mention any two methods to solve continuum problems.
1. Raleighritz method
2. Galerkin method

List the properties of shape functions. SF for
1D bar element N1=0, N2= 0 at node 1
N1=0 N2=1 at node 2 . Diff. Of S.F. S.F are constant

Define truss.
Structural member which is subjected to either tensile or compression

What is weighted residual methods.
It’s a method in FEA for accurate solution avoiding error
(residue = error)

Different methods to solve weighed residual problem.Point
allocation, Sub domain , Galerkein,least square.

Explain the principle of virtual work.
If the force and displacement are unrelated by cause effect relation then the work is said to be
virtual work.



Explain the principle of virtual displacement.
Actual displacement is considered without bothering amount of force is called virtual
displacement .

What are different types of shape functions.
Diff types are Lagarangian and Hermite Shape function

Differentiate two types of shape functions.
Lagarangian shape function only for variable
Hermite shape function is for both variable and its derivative

Mention some advantages of FEA over solid mechanics.
1.Applied for complicated structure
2. Analysis is simple

3. More accurate solution

Define Young’s Modulus and Poisson’s Ratio.
E - it is the ratio of stress and strain
p- It is the ratio of lateral strain and longitudinal strain

Mention different types of elastic constants.
Young’s modulus, shear modulus, bulk modulus

Specify the terms required to solve FEA problem.
Meshing , properties of material,boundry condition and initial condition.

What are the assumptions made in linear static problems.
all displacement is small, material is isotrpic,linear,elastic solid with E and p

Which is the most accepted form of numerical integration in FEM?
Gaussian Quadrature

List the different approaches to derive integral equation
Direct method , variation method, weighed residual method, energy method

What are the advantages of symmetrical matrix.
symmetrical matrix simplifies the calculation

What are the different types of errors in FEA?
Modeling error , Descritized and Numerical error

What are the advantages of isoparametric elements
Useful in modeling structure with curved edges
They are versatile & they are used in 2-D and 3-D elasticity problems

Q.76). Define frontal method for finite element matrices.
In 3- dimensional problems, the size of the stiffness matrix increases rapidly even with the
banded method of modeling. An alternative direct method that results in considerable saving
in the use of computer memory is called frontal method.




Q.77) What is the another name of the 3-dimensional frames
Space frames.

Q.78). Define beam elements.
Beam elements are slender members that are used for supporting transverses loading.

Explain preprocessor steps.
Determining the Nodal coordinates, connectivity, boundary condition, material information

Explain processing steps.
Stiffness generation, modification, solutions to the equation resulting in evolution.

Explain post processing steps.
Deformation confirmation, mode shapes, temperature and stress distribution, interpretation

What are the difference b/w beams and plane frames.
It is similar to beams expect that axial loads &axial deformations are present. The elements
also have different orientation.

Mention some common material properties.
Isotropic, orthrotropic, ductility, brittleness

What are the different types of analysis.
Thermal, structural (load), fluid, electromagnetic analysis

Define steady state analysis.
The analysis carried out at constant temperature.

What is the advantage of subjecting solids to axisymmetric loading.
Axisymmetric loading reduces the 3-D problem into 2-D problems because of total symmetry
about the z-axis.

Define CST elements.
The constant strain triangle is that where the displacement inside an element is represented by
3-nodal displacement (3-shape functions).

How to generate the data files for larger problems in FEA.Using
MESHGEN program generates data files.

Define mesh plotting
It is the convenient way of reviewing the coordinate and connectivity data is by plotting it
using computer.

Explain lumped mass matrices.

It is the total element mass in each direction is distributed equally to the nodes of the element,
and the masses are associated with translational degrees of freedom.

Briefly explain steps involved in Lagrangian method



e Formulation of potential energy function.

assuming displacement function

Checking displacement function considering boundary condition

Substitute differential function in potential energy equation

Potential energy function is minimized

e Unknown parameters are determined and substituted in assumed equation

Explain steps involved in Gallerkins method.

Formulate differential equation of the equilibrium

Assume trial function, which satisfies boundary conditions

Substitute displacement function in differential equation then assume the difference due to
approx. function be ‘R’ (residue)

Use gallerkin formula

Determine unknown terms and then substitute in differential function

Define jacobian matrix.
The matrix which is defined explicitly in terms of the local coordinate is known as
jacobian(J).

Mention six components of stress.3
linear stress along X, y, z direction
3 lateral stress along X, vy, z direction

Mention six components of strain.3
linear strain along X, y, z direction
3 lateral strain along x, y, z direction

Define Winkler foundations.
Large beams are supported on soil form a class of applications known as winkler foundations.

Define variational principle
The problem which specifies a scalar quantity potential energy is defined in an integral form.

How to solve the prismatic problems.
The coefficient of the ordinary differential equation are independent of one of the coordinate
and the solution of the system can frequently carried out efficiently by standard analytical
methods.

Define stress & strain.
Stress is the ratio of applied load to its area.
Strain is the ratio of change in length to its original length.

Mention the two distinct procedures available for obtaining the approximation in theintegral
forms.

Method weighed residuals.

Method of variation functional.
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